ENESANS Quick Start Guide

RZ/G3S
Quick Start Guide for RZ Multi-OS Package

Introduction

This document outlines the procedure for integrating the RZ Multi-OS Package into the RZ Verified Linux
Package (referred to as VLP) for the RZ/G3S. By integrating the Multi-OS Package, users can efficiently
establish a Multi-OS environment wherein Linux operates on the Cortex®-A55 and FreeRTOS/BareMetal
runs on the Cortex-M33, with support for Inter-Processor Communication between these CPU cores.

This package requires the RZ Flexible Software Package (FSP) for an RTOS/BareMetal environment. The
figure below illustrates the software stack for integrating the RZ Multi-OS Package with the RZ/G3S:

RZ Multi-OS Package

RZ MPU Verified Linux Package [6.1-CIP] RZ Flexible Software Package

HAL Driver

GTM GPT
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Here are brief descriptions of each component related to RZ Multi-OS Package:

e RZFSP

This software package consists of production ready peripheral drivers, FreeRTOS and portable
middleware stacks and best in-case HAL drivers with low memory footprint.
e OpenAMP

The framework includes the software components required for Asymmetric Multiprocessing (AMP)
systems, such as Inter-Processor Communication.

Target Device
RZ/G3S
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1. Specifications
Table 1-1 lists the on-chip peripheral modules to be used in this package.

Table 1-1 Peripheral modules to be used in this package

Peripheral module Usage

Message Handling Unit (MHU) Configure Inter-Processor Interrupt.

Serial Communications Interface with FIFO (SCIFA) | Perform standard serial communications sending
and receiving console messages.

Interrupt controller (INTC) Handle the following types of interrupts as shown
below for example:

e Processors should receive interrupts during
buffered serial communications.

e MHU module fires Inter-Processor Interrupt.

General Purpose Input Output (GPIO) Configure 1/0O lines used by serial communications.

General Timer (GTM) Configure the tick for FreeRTOS.

2. Verified Operation Conditions
Table 2-1 shows the verified operation conditions.

Table 2-1 Verified Operation Conditions

Item Contents

Integrated Development Environment e? studio 2025-12 or later

Toolchain GNU Arm Toolchain 13.3.Rel1 AArch32 bare-metal
target (arm-none-eabi)

Dependent Software o RZ Flexible Software Package (FSP) v4.0.0
e RZ/G Verified Linux Package v3.0.7
¢ RZ MPU Verified Linux Package v4.0.1

3. Sample Program Setup

3.1 Flexible Software Package Setup

Multi-OS Package expects RZ Flexible Software Package (FSP) to be installed in advance. For details on
the installation, please refer to Getting Started with Flexible Software Package.

3.2 Integration of Multi-OS Package related stuff

3.21 Using RZ MPU VLP v4.0.1

This section describes how to integrate OpenAMP related stuff to RZ Verified Linux Package [6.1-CIP]
(hereinafter referred to as VLP). The steps are based on SMARC EVK of RZ/G3S Linux Start-up Guide
(hereinafter referred to as Linux Start-up Guide) included in RZ MPU VLP v4.0.1.

1. Follow the procedure stated from the beginning of 2.2 Building Images to (3) Add layers of Linux Start-
up Guide.

2. Download Multi-OS Package (r01an8260ej0400-rz-multi-os-pkg.zip) to a working directory and run the
commands stated below:

cd ~/rzg vlp <pkg ver>
$ unzip <Multi-0S Dir>/r01an8260ej0400-rz-multi-os-pkg.zip
$ tar zxvf r01an8260ej0400-rz-multi-os-pkg/meta-rz-features multi-os v4.0.0.tar.gz

Here, <Multi-OS Dir> indicates the path to the directory where Multi-OS Package is placed.
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3. Add the layer for Multi-OS Package, simply run the helper script and select the meta-rzg3s-vip4 layer
from the list.

$ cd build
$ bash ../meta-rz-features/meta-rz-multi-os/add meta layer.sh
(Optional for remoteproc support)

4. Uncomment the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-rzg3s-
vipd/conf/layer.conf for enabling remoteproc support:

MACHINE FEATURES:append = " RZG3S_CM33 REMOTEPROC"
#MACHINE FEATURES:append = " RZG3S CM33 FIRMWARE LOAD"
#MACHINE FEATURES:append = " RZG3S_CM33 COLDBOOT"
#MACHINE FEATURES:append = " RZG3S_AWO SUPPORT"

5. Start a build as described in (5) Start a build of 2.2 Building Images as shown below:

$ MACHINE=smarc-rzg3s bitbake core-image-<target>

For details on the allowable value of <target>, please refer to Linux Start-up Guide.

3.2.2 Using RZ/G VLP v3.0.7

This section describes how to integrate OpenAMP related stuff to RZ/G Verified Linux Package [5.1-CIP]
(hereinafter referred to as VLP). The steps are based on SMARC EVK of RZ/G3S Linux Start-up Guide
(hereinafter referred to as Linux Start-up Guide) included in RZ/G VLP v3.0.7.

1. Follow the procedure stated from the beginning of 2.2 Building Images to (3) Add layers of Linux Start-
up Guide.

2. Download Multi-OS Package (r01an8260ej0400-rz-multi-os-pkg.zip) to a working directory and run the
commands stated below:

cd ~/rzg vlp <pkg ver>
$ unzip <Multi-0S Dir>/r01an8260ej0400-rz-multi-os-pkg.zip
$ tar zxvf r01an8260ej0400-rz-multi-os-pkg/meta-rz-features multi-os v4.0.0.tar.gz

Here, <Multi-OS Dir> indicates the path to the directory where Multi-OS Package is placed.

3. Add the layer for Multi-OS Package, simply run the helper script and select the meta-rzg3s-vip3 layer
from the list.

$ cd build
$ bash ../meta-rz-features/meta-rz-multi-os/add meta layer.sh
(Optional for remoteproc support)

4. Uncomment the following line in meta-rz-features/meta-rz-multi-os/meta-rzg/meta-rzg3s/meta-rzg3s-
vip3/conf/layer.conf for enabling remoteproc support:

MACHINE FEATURES append = " RZG3S_CM33 REMOTEPROC"
#MACHINE FEATURES append = " RZG3S CM33 FIRMWARE LOAD"
#MACHINE FEATURES append = " RZG3S CM33 COLDBOOT"
#MACHINE FEATURES append = " RZG3S_AWO SUPPORT"

5. Start a build as described in (5) Start a build of 2.2 Building Images as shown below:

$ MACHINE=smarc-rzg3s bitbake core-image-<target>

For details on the allowable value of <target>, please refer to Linux Start-up Guide.
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3.3 Note for integration

The peripherals which are NOT enabled enter Module Standby Mode after Linux kernel is booted up. That
means the peripherals used on CM33 side might stop working at that time. To avoid such a situation, Multi-
OS Package incorporates the patch below:

e 0001-Set-SCIF1-and-OSTM1-OSTM2-as-critical-clock.patch

This patch prevents SCIF channel1, GTM channel 1 and GTM channel 2 used in RPMsg demo program from
entering Module Standby Mode. If you have any other peripherals which you would like to stop entering
Module Standby implicitly, please update the patch as shown below:

diff --git a/drivers/clk/renesas/r9a08g045-cpg.c b/drivers/clk/renesas/r9%9a08g045-cpg.c
index 33a204fbe25c..dba2b4925e66 100644
--- a/drivers/clk/renesas/r9a08g045-cpg.c
+++ b/drivers/clk/renesas/r9%9a08g045-cpg.c
@@ -381,6 +381,9 @@ static const unsigned int r9a08g045 crit mod clks[] _ initconst = {
MOD CLK BASE + R9A08G04571A557CLK,
MOD CLK_BASE + R9A08G0457DMAC7ACLK,
MOD CLK_BASE + R9AO8G0457VBAT7BCLK,
+ MOD CLK BASE + R9A08G045 xxxx,
}i

With respect to the allowable value for xxxx above, please refer to the source code below:
https://github.com/renesas-rz/rz_linux-cip/blob/rz-6.1-cip43/drivers/clk/renesas/r9a08g045-cpg.c#L375-L381

3.4 Deployment of RZ/G VLP

With respect to the deployment of Linux kernel, device tree and root filesystem for RZ/G3S, please refer to
Linux Start-up Guide.

4. Sample Program Invocation on RZ/G3S

4.1 Hardware Setup

1. Connect J-Link to RZ/G3S SMARC EVK. For details, please refer to Getting Started with Flexible
Software Package.

2. Connect Pmod USBUART to the upper side of PMOD 3A connector of Smarc EVK as shown below for
securing the console for sample program.

o
[

PMOD 3A

Figure 4-1. Connection between Pmod USBUART and RZ/G3S SMARC EVK
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4.2 CM33 Sample Program Setup

Here are the procedures for setting up the sample program running on CM33:

1. Extract r01an8260ej0400-rz-multi-os-pkg.zip on your development PC.

2. Extract <device>_rpmsg_<com_type>_example.zip included in r01an8260ej400-rz-multi-os-pkg.
Here, <device> should be any of rzg3s_cm33 or rzg3s_cm33_fpu. Also, <com_type> should either of

linux-rtos or rtos-rtos.

w

Open e? studio 2025-12 and click File > Import.
4. Double-click General and select Existing Projects into Workspace as shown in Figure 4-2:

B impe m]
Salwct
Crgae sviw i et e s archive 118 o desctery. Il 4 l]

Select an import wizand:

B i File
o CRSIS Pack
! Exiting Prejects inle Weskspace

, [Fibe Sysiem
= GNUSRM-NOMEFZDS-Y) propct coivwersan 10 GCC AR Embedded
] Preferences

3 Progects from Fobkler o Sichive

Figure 4-2. Import sample project (1)

5. Input the path to the directory of sample project you would like to import to Select root directory, press
Enter key and click Finish button.

& import | X
Import Projects ()
Select a directory to search for existing Eclipse projects. # /
(O Select root directory: Browse...
O Select archive file Brows:
Projects:
@ rzg3s_cm33_rpmsg_linux-rtos_example (rzg3s_em33_rpmsg_linue-|  Select All
Deselect All
Refresh
y pace
[0 Close newly imported projects upon completion
[JJ Hide projects that already exist in the workspace
Working sets
() Add project to working sets New...
Select...

Figure 4-3. Import sample project (2)
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(Optional for configuring RPMsg channel)

6. By default, RPMsg channel 0 is configured to be used on CM33. If you would like to change the channel,
you need to open the property of MainTask#0 on FSP Smart Configurator, specify the channel number
you would like to use for Thread Context and push Generate Project Content button. If Generate
Project Content pop-up is shown, click Proceed to reflect the changes to source code.

” [*)
Staces Confgurain

Threads &) NewThread &) Remove (= MainTask#0 Stacks &) New Stack >

v & HAL/Common 0 Add stacks to the selected thread by using the 'New Stack’ toolbar button (above), or by pasting here from the clipboard.

4 g_ioport /0 Port Driver on r_ioport
& FreeRTOS Port (rm freertos_port)
4 Heapa
@ g_mhu_ns0 Message Handling Unit Driver (NonSecug
@ g_uart2 UART Driver on r_scif_uart
@ OpenAMP
4 g_canfdo CANFD Driver on r_canfd

@ Blinky Thread

& MainTask#0

< > 8 Generate Project Content X

Objects. ¢ New Object >
% | 2 Configuration must be saved before generating project content.

} Proceed with save and generate?

[J Always save and generate without asking

Proceed Cancel
Summary |BSP | Clocks Interrupts | Event Links | Stacks | Components

(21 Problems | @ Console | [T] Properties X | @ Smart Browser| I Smart Manual
MainTask#0

Settings  Property Value
Stats
Memory Allocation
Timers
Optional Functions
Logging

v Thread
Symbol MainTask
Name MainTask#0
Stack size (bytes) 0%
Priority 1
[_Thread Context T |

‘Memory Allocation Dynamic
Allocate Secure Context Enable

Figure 4-4. RPMsg Channel Setting

(Optional for remoteproc support)
7. Change the value for ENABLE_REMOTEPROC defined in platform_info.h from 0 to 1 as shown below:

#define ENABLE REMOTEPROC (1U)
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(Optional for CM33 cold boot support)
8. Configure Launch Cortex-A55(core0) as Enabled.

u e2studio_122025_workspace - rzg3s_cm33_rpmsg_linux-rtos_example/configurationxml - e studio

File Edit Source Refactor Navigate

| B~ R~ Binith~ @~

Project Explorer X B %

v 125 rzg3s_cm33_rpmsg_linux-rtos_example

> [l Includes

yBr

> 3 rz_gen

~ (B src

> [€ blinky_thread_entry.c

» [ blinky_thread_entry.h
» [8 ca55 start.c
> «€a55 _starth
> cm33_fpu_start.c
cm33_fpu_start.h
conscle.h
hal_entry.c
MainTask_entry.c
mbed_printf_implementation.c
mbed_printf_implementation.h
OpenAMP_RPMsg_cfg.h
Pplatform_info.c
platform_info.h
rpmsg_demo.c
rsc_table.c
rsc_table.h
r2g3_rproc.c

&

BEEFE

PRREEREE

&

serial.c
sys_init.c

o BEE R

§

Iﬁ
s

("}

i configur

Lgy rzcig.
= rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat.jlink

| rzg3s_cm33_rpmsg_linux-rtos_example Debug Flat.launch
=) rzg3s_cm33_rpmsg_linux-rtos_example Release_Flatjlink
% rzg3s_cm33_rpmsg_linux-rtos_example Release_Flat.launch

Search Project Renesas Views

Run Renesas 365 Renesas Al Window Help

= B § [rg3s_cm33_rpmsg_linux-rtos_example] FSP Configuration X

Board Support Package Configuration

Device Selection
FSP version: 4.0.0
Board: RZ/G3S Evaluation Kit (SMARC)
Device: RIADBGO43533GBG
Core: Cortex-M33
RTOS: FreeRTOS

Q &\J Mot Connected

bl =

Generate Project Content

$ummaryloclu Pins | Interrupts | Event Links | Linker Sections | Stacks | Components

= a X

= | B§C/C++ | 45 Debug

Qutline X t =0

There is no active editor that provides
an outline,

Problems Console Properties X Smart Browser Smart Manual M & B4 § =0
RZ/G3S Evaluation Kit (SMARC)
Settings  Property Value

~ ROAQEG045533GBG(Cortex-M33)
part_number ROADEG0O45533GBG
rom_size_bytes 0
ram_size_bytes 131072
package_style LFBGA
package_pins 359

v RZ/G Common
Secure stack size (bytes) 0x1000
Main stack size (bytes) Ox 1000
Heap size (bytes) Ox 4000
MPU Vee (mV) 3300
Parameter checking Disabled
Assert Failures Return FSP_ERR_ASSERTION
PFS Protect Enabled
C Runtime Initialization Enabled
Early BSP Initialization Disabled

v RZG3S(Cortex-M33)

I Launch Cortex-A55{core0) Enabled |
Launch Cortex-M33_FPU Disabled
Clock initialization Disabled

v RZG3S Family
Enable inline BSP IRQ functions Enabled

Figure 4-5. Linux boot configuration from CM33 cold boot

(Optional for CM33 cold boot support)
9. Click Generate Project Content to generate the updated source code:

-rtos_example/configurationxml - &* studio

t  Renesas Views

Run Renesas 365 Renesas Al Window Help

iﬁ,} [rzg3s_cm33_rpmsg_linux-rtos_example] FSP Configuration X

Board Support Package Configuration

Device Selection

Q ¢
= (=]

Generate Project Content

Figure 4-6. Generate Project Content
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10.Build the project from Choose Project > Build Project.

11.1f the build is successfully completed, the following files should be generated in Debug and/or Release
folder in accordance with the active Build Configuration.

e <device> rpmsg_linux-rtos_example.elf (Note 1)

e <device>_rpmsg_linux-rtos_example.srec (Note 1)
e <device>_rpmsg_rtos-rtos_example.elf (Note 1)

e <device>_rpmsg_rtos-rtos_example.srec (Note 1)

Notes: 1. The possible string for <device> is any of rzg3s_cm33 and rzg3s_cm33_fpu.

4.3 CM33 Sample Program Invocation for communicating with Linux
4.3.1 CM33 Sample Program Invocation using Segger J-Link

You need to follow the following steps to invocate CM33 sample program with Segger J-Link.

(Optional for CM33 cold boot support)
1. Select Run > Debug Configurations... if CM33 is configured as Boot CPU for RZ/G3S.

8 e2studio_122025_workspace - €* studio
File Edit Source Refactor Navigate Search Project RenesasViews [Run |Renesas365 RenesasAl Window Help

DR - Dinipv@Q- Renesas Debug Tools >
Project Explorer X == = s
v[i5 rzg3s_cm33_rpmsg _linux-rtos_example [Debug]| P
> ,':;D Binaries Run Ctrl+F11
n)) Includes 4§ Debug F11
B
G Run History >
S Run As >
> > Debug Run Configurations...
» B> rcfg
= script Debug History 5
5 configuration.xml ¥ DebugAs >
() rzcfgtxt [ Debug Configurations...

r2g3s_cm33_rpmsg_linux-rtos_example Debug_Flat jlink
X) r2g3s_cm33_rpmsg_linux-rtos_example Debug_Flat.launch Breakpoint Types >
r2g3s_cm33_rpmsg_linux-rtos_example Release_Flat jlink

X] rzg3s_cm33_rpmsg_linux-rtos_example Release_Flat.launch

Figure 4-7. Debug Configuration (1)

(Optional for CM33 cold boot support)
2. Click rzg3s_cm33_rpmsg_<com_type>_example Debug_Flat or
rzg3s_cm33_rpmsg_<com_type>_example Release_Flat.

{8 Debug Configurations a] X
Create, manage, and run configurations 2 g\
T EPEX B Y-

Name: rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat

type filter text [2) Main | %5 Debugger| > Startup | [[] Common | &/ Source

Q]

= Project:
[£] C/C++ Remote Application

EASE Script r2g3s_cm33_rpmsg _linux-rtos_example Browse...
[£] GDB Hardware Debugging

[£7] GDB Simulator Debugging (RH850)
@’ IronPython Run

C/C++ Application:

Debug/rzg3s_cm33_rpmsg_linux-rtos_example.elf

@ IronPython unittest Variables... Search Project... Browse...
& iorirn Build (i required) before launching

& Jython unittest

@ Launch Group Build Configuration: Use Active v
[ PyDev Django - . == )

A PyDev Govgle App Rin O Enable auto build O Disable auto build

@ Python Run © Use workspace settings Configure Workspace Settings.

&’ Python unittest
+ [£7] Renesas GDB Hardware Debuggin
[c*] r2g3s_cm33_rpmsg_linux-rtos_example Debug_Flat|
[€] rzg3s_cm33_rpmsg_linux-rtos_example Release_Flat
[c7 Renesas Simulator Debugging (RX, RL78)

Figure 4-8. Debug Configuration (2)
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(Optional for CM33 cold boot support)
3. Click Debugger tab and select Connection Settings as shown below:

Name] rzg3s_em33 rpmsg linux-rtos_example Debug Fiat
[2) Main |%5 Debugger| > Startup | [=] Common | &/ Source

Debug hardware: J-Link ARM v Target Device:  ROAO08G045S33GBG_!

GDB Settings Debug Tool Settings

v J-Link
Type UsB v
J-Link Serial (Auto)
Settings File ${workspace_loc:/${ProjName}}/${LaunchConfigName},jlink
Script File
Log File S{workspace_loc:/${ProjName}}/JLinkLog.log
Low Power Handling No v

v IP Connection
Connection Method IP via LAN

Figure 4-9. Debugger - Connection Settings

(Optional for CM33 cold boot support)
4. Configure Reset after download as Yes.

Name: rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat

2 Main EDebugger # Startup | [T] Common | % Source

Debug hardware: J-Link ARM v~ Target Device: | RSAOBGD45533GBG_!

GDB Settings Connection Settings  Debug Tool Settings

Port Number
Password
v Interface
Type SWD v
Speed (kHz) 15000 v
v JTAG Scan Chain
Multiple Devices No v
IRPre 0
DRPre 0
v Connection
Register initialization No v
Reset at the beginning of cennection No v
Reset at the end of connection No v
Reset before download No v
[ reaswsonions -
ID Code (Bytes) FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
Figure 4-10. Reset after download Setting
(Optional for CM33 cold boot support)
5. Select Startup tab and click Add... as shown below:
Name: rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat
B Main| % Debugger [C] Common | & Source
Initialization Commands
() Reset and Delay (seconds): 0
[ Halt
Load image and symbols
‘ Filename Load type Offset (hex) On connect Add...
} Program Binary [rzg3s_cm33_rpmsg_linux-rtos_example.elf] Image and Symbols Yes
Figure 4-11. Add download module (1)
R01QS0085EJ0400 Rev.4.00 Page 10 of 24

Mar.31.26 RENESAS




RZ/G3S Quick Start Guide for RZ Multi-OS Package

(Optional for CM33 cold boot support)
6. Click Workspage..., choose rzg3s_cm33_rpmsg_<com_type>_example_cm33boot.srec and click
OK.

& Add download module x

Specify download module name:

Variables... Search Project... File System...

OK Cancel
Add download module O *
Select a workspace resource
w [= Debug

e n

> & z_gen

3 = src

. & Add download module X
compile_commands.json

& makefile 5
B makefleink Specify download module name:
[L memory_regions.Id S{workspace_loc\rzg3s_cm33_rpmsg_linux-rtos_example\Debugirzg3s_
[ objects.mk
= rzg3s_em33_rpmeg linux-rtos_example_cm33boot.crec Variables... Search Project... File System...
=| rzg3s_cm33_rpmsg_linux-rtos_example_cm33fpu.srec
= rzg3s_cm33_rpmsg_linux-rtos_example_non_secure_code.bin
= rzg3s_cm33_rpmsg_linux-rtos_example_nen_secure_vector.bin Cancel
= rzg3s_cm33_rpmsg_linux-rtos_example_secure_code.bin
= rzg3s_cm33_rpmsg_linux-rtos_example_secure_vecter.bin
b r293s5_cm33_rpmsg_linux-rtos_example.elf

o] e

Figure 4-12. Add download module (2)

(Optional for CM33 cold boot support)

7. Configure Load type of Program Binary [rzg3s_cm33_rpmsg_<com_type>_example.elf] and
rzg3s_cm33_rpmsg_<com_type>_example_cm33boot.srec as Symbols only and Image only,
respectively.

Name: ings‘cm33_.rpﬂgalinux-rtos-example Debug_Flat

[) Main | 5 Debugger | = Startup | [] Common & Source
Initialization Commands
[_) Reset and Delay (seconds): 0
[ Halt

Load image and symbols

Filename Load type Offset (hex) On connect
Program Binary [rzg3s_cm33_rpmsg_linux-rtos_example.elf] | Symbols only Yes
rzg3s_cm33_rpmsg_linux-rtos_example_cm33boot.srec [C:... | Image only 0 Yes i

Figure 4-13. Configuration of Load type
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8. Click Debug button to launch Debug Perspective.

Q Debug Configurations

Create, ge, and run config

PR BY -

type filter text

[€] C/C++ Application

[€] C/C++ Remote Application

.| EASE Script

[€] GDB Hardware Debugging

[€7] GDB Simulater Debugging (RH850)

@' IronPython Run

a IronPython unittest

@" Jython run

FU Jythen unittest

@ Launch Group

PyDev Django

43 PyDev Google App Run

ep Python Run

@ Python unittest

w [c7] Renesas GDB Hardware Debugging

[©7] rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat
[£7] rzg3s_cm33_rpmsg_linux-rtos_example Release_Flat

E Renesas Simulator Debugging (RX, RL78)

Filter matched 18 of 20 items

@

Name: rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat

L)

[5) Main | %5 Debugger [ startup| Common | &/ Source
Initialization Commands
[C) Reset and Delay (seconds): 0
[ Halt

Load image and symbols

Filename Load type Offset (hex)  On connect
2 Program Binary [rzg3s_cm33_rpmsg_linux-rtos_example.elf] Symbols only Yes Add...
[i rzg3s_cm33_rpmsg_linux-rtos_example_cm33boot.srec [C:... Image only 0 Yes ] Edit...
Remove
Move up
Move down
Runtime Options
) Set program counter at (hex):
18 Set breakpoint at: main
[_J Resume
Run Commands
Revert Apply

Figure 4-14. Debug Perspective Launch

If Confirmation Perspective Switch window below appears, press Switch to continue:

(2

a Confirm Perspective Switch

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

Switch to this perspective?

[J Remember my decision

X

Figure 4-15. Confirm Perspective Switch
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9. When the debug perspective is opened, Program Counter (PC) should be located at the top of
Entry_Function_S function. Then, you need to press the button indicated by a red arrow in Figure 4-16:

8 e2studio_122025_werkspace - rzg3s_cm33_rpmsg_linux-rtos_example/rz/fsp/src/bsp/cmsis/Device/RENESAS/Source/systems.c - & studio = o X
File Edit Source Refactor Navigate Search Project Pydev RenesasViews Run Renesas365 Renesas Al Window Help

| ®~-{ - Bivw BB R B-Qib~ts o~ R RSie N S %O Q| &) Not Connected
| B c/ce+ 45 Debug A
Debug X B % ‘i=>| & 8 =0 [€] systems.c X =3 Eventpoints X % =l

v [c7] rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat [R

1 /** @cond DOXYGEN_IGNORE_ATTRIBUTE */ w X % &
~ i rzg3s_cm33_rpmsg_linux-rtos_example.elf [1] [core | ©__sttribute_((noked)) ;
- " = PC:0/80A:0/4 | 8 | 4
v _@lhread #11 (single core) [core: 0] (Suspended : ! i J DOXYGEN IGNORE ATTRIBUTE */ | ‘ |
= Entry,Function_S{) at systems.c:177 0x239dc | = = Tpe Address
=1 |
sl arm-none-eabi-gdb (16.2) i ® * Entry Fun(ticr: when debugging RAM load using a debugger(] ()& Trace Start
3] Renesas GDB server (Host) \{mid Entry_Function S (void) (O @ Trace Stop
/* Set the main stack pointer to BSP_PRV_SECURE_STACK_TOP Qf Trace Record
__asm volatile ("msr msp, %0" (1) € Event Break

: (O Timer Start
" (BSP_PRV_SECURE_STACK_TOP) a5 .

S
E -

__asm volatile ("b.w %"

i" (&entry_function_sub)

¥

]
b
| §
|
Sg’i
e

}
= static void entry_function_sub (void)

/* Set Secure vector address to SYSC */
R_BSP_SECURE_VECTOR_SET((uint32_t) 8_ Secure_Vectors);

__asm volatile ("b.w %e"

i" (&Reset_Handler_S)

)

Project | Saved Templates
Console X Registers Problems Smart Browser Debugger Console Memory Executables a5

EX Rk BRERMESE 2B
rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat [Renesas GDB Hardware Debugging] [pid: 32]
Warning: The Operating Frequency needed to perform the Run-Break Time Measurement could not be calculated.
Warning: Please go to Debug Tool Settings and set the Operating Frequency[MHz].

GDB Server for Renesas targets.
Version 10.4.0.v20251124-120209 [b5e5682e] (Nov 24 2825 15:56:35)

Starting server with the following options:
Raw options ¢ C:\Users\a5149982\.eclipse\com.renesas.platform_1206726211\DebugComp\\RZ\e2-server-§
Using J-Link version V8.60 - C:\Users\a5149982\.eclipse\com.renesas.platform_1206726211\DebugComp\RZ\ARM\Segger v8.60.0\:

Figure 4-16. Start to debug RPMsg Sample Program (1)

RO1QS0085EJ0400 Rev.4.00 Page 13 of 24
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10.The program should stop at the top of the main function. Then, click the same button as the previous
step.

a e2studio_122025_workspace - rzg3s_cm33_rpmsg_linux-rtos_example/rz_gen/main.c - ¥ studio - a X

File Edit Source Refactor MNavigate Search Project Pydev RenesasViews Run Renesas365 Renesas Al Window Help

| R~ Bivw BN R R - Q-GS eSS ® O Q&) Not Connected
5| BC/Crr |45 Debug | B
Debug X =R iv ‘ & 8 = B [gsystemsc (€] main.c X = B Eventpoints X ¥ = H
v [£7 rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat [R ;%5 99 eo = int main(void) { ) w X % & ‘
v i@ rzgds_cm33_rpmsg_linux-rtos_example.elf [1] [core | E_f5p_‘-°"“°"_?hfe‘?d_f°”“t =9;
v @ Thread #11 (single core) [core: 0] (Suspended: | i g_fsp_common_initialized = false; PC: 0/8 0A: 0/4 ‘ %
= main{) at main.c:9 Bx2418 S #if (configSUPPORT_DYNAMIC_ALLOCATION) Type Address
p arm-none-eabi-gdb (16.2) 2 #if defined(BSP_MCU_GROUP_RZN2H) || define [ Tacesan
3 Renesas GDB server (Host) - 'J:ifiz:g(gjp_”cu_ﬁmp_un“) || define E] B Trace Stop
= #else l;l % Trace Record
/* Define Heap reagion (this is used only ) c‘;j Event Break
vPortDefineHeapRegions (xHeapRegions); [DIpe - Timer Start
#endif O Timer Stop
#endif

* Create semaphore to make sure common init is done befor
_fsp_common_initialized_semaphore =
= #if configSUPPORT_STATIC_ALLOCATION
xSemaphoreCreateCountingStatic(
= #else
xSemaphoreCreateCounting(

#endif
256, 1
= #if configSUPPORT_STATIC_ALLOCATION
» &g_fsp_common_initialized_semaphore_
#endif
H

e if (NULL == g_fsp_common_initialized_semaphore) {
rtos_startup_err_callback(g_fsp_common_initialized_sem

}

/* Init RTOS tasks. */
ol < Project | Saved Templates

Console X  Registers Problems Smart Browser Debugger Console Memory Executables il =

X g REREFEF 2B
rzg3s_cm33_rpmsg_linux-rtos_example Debug_Flat [Renesas GDB Hardware Debugging] [pid: 32]
Warning: The Operating Frequency needed to perform the Run-Break Time Measurement could not be calculated.
Warning: Please go to Debug Tool Settings and set the Operating Frequency[MHz].

GDB Server for Renesas targets.
Version 1@.4.8.v20251124-120209 [bSe5682e] (Nov 24 2025 15:56:35)

Starting server with the following options:
Raw options : C:\Users\a5149982\.eclipse\com.renesas.platform_1206726211\DebugComp\\RZ\e2-server-{
Using J-Link version V8.6@ - C:\Users\a5149982\.eclipse\com.renesas.platform_1206726211\DebugComp\RZ\ARM\Segger_v8.6@.0\:

Figure 4-17. Start to debug RPMsg Sample Program (2)

11.Now that CM33 sample program has been started, the following message is shown on the console
connected to Pmod USBUART: (Note)

Successfully probed IPI device

Successfully open uio device: 42F00000.rsctbl.
Successfully added memory device 42F00000.rsctbl.
Successfully open uio device: 43000000.vring-ctlO.
Successfully added memory device 43000000.vring-ctlO.
Successfully open uio device: 43200000.vring-shmO.
Successfully added memory device 43200000.vring-shmO.
Initialize remoteproc successfully.

creating remoteproc virtio

initializing rpmsg vdev

At this point of time, the CM33 program is waiting for the establishment of rpmsg channel with CA55.

RO1QS0085EJ0400 Rev.4.00 Page 14 of 24
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4.3.2 CM33 Sample program invocation with u-boot
You can invoke CM33 sample program from u-boot by following the procedure described below:

1. Copy the binary files generated at 8 of section 4.2 to microSD card.

2. Insert the microSD card into SDO of RZ/G3S SMARC EVK.

3. Turn on SMARC EVK by pressing the Power button for a few seconds.

4. Hit any key to stop autoboot within 3 seconds after the following message is shown in the console

U-Boot 2024.07 (Sep 22 2025 - 10:51:32 +0000)
CPU: Renesas Electronics CPU rev 1.0

Model: smarc-rzg3s
DRAM: 896 MiB

Core: 31 devices, 15 uclasses, devicetree: separate

MMC : sd@11c00000: 0, sd@11cl10000: 1, sd@11c20000: 2
Loading Environment from MMC... Reading from MMC(0)... OK
In: serial@1004b800

Out: serial@1004b800

Err: serial@1004b800

Net:

Error: ethernet@1l1c30000 No valid MAC address found.
No ethernet found.

Hit any key to stop autoboot: 0
=>

5. Load the binary files you copied at step1 from microSD card to RAM by executing the commands stated
below on the console. Here, N stands for the partition number in which you stored the binary files.

e ForCM33
=> setenv cm33 start 'dcache off; mmc dev 1;
fatload mmc 1:N 0x00023000 rzg3s cm33 rpmsg linux-rtos example secure vector.bin;
fatload mmc 1:N 0x00023890 rzg3s_cm33_rpmsg_linux-rtos_example_secure_code.bin;
fatload mmc 1:N 0x10023800 rzg3s_cm33_rpmsg_linux-rtos_example non_secure_vector.bin;
fatload mmc 1:N 0x10023840 rzg3s_cm33_rpmsg_linux-rtos_example non_secure_code.bin;
mw.l 0x11020844 0x0001312C; mw.l 0x11020848 0x0001312C;
mw.l 0x1102084C 0x00023000; mw.l 0x11020850 0x10023800;
mw.l 0x11010504 0x00010001; mw.l 0x11010804 0x00040004;
mw.l 0x11010804 0x00070007; dcache on'
=> saveenv

=> run cm33_ start

e For CM33-FPU
=> setenv cm33fpu start 'dcache off; mmc dev 1;
fatload mmc 1:N 0x00060000 rzg3s cm33-fpu rpmsg linux-rtos example secure vector.bin;
fatload mmc 1:N 0x00060890 rzg3s cm33-fpu rpmsg linux-rtos example secure code.bin;
fatload mmc 1:N 0x10060800 rzg3s cm33-fpu rpmsg linux-rtos example non secure vector.bin;
fatload mmc 1:N 0x10060840 rzg3s cm33-fpu rpmsg linux-rtos example non_ secure code.bin;
mw.l 0x11020884 0x0001312C; mw.l 0x11020888 0x0001312C;
mw.l 0x1102088C 0x00060000; mw.l 0x11020890 0x10060800;
mw.l 0x11010504 0x01000100; mw.l 0x11010804 0x04000400;
mw.l 0x11010804 0x07000700; dcache on'
=> saveenv

=> run cm33fpu_start

6. CM33/CM33-FPU sample program is now started.
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4.3.3 CM33 Sample Program Invocation from remoteproc

On RZ/G3S SMARC EVK, you can invoke RPMsg sample program with remoteproc by following the
procedure stated below:

1. Booting up Linux by following 5. Booting and Running Linux of Linux Start-up Guide
2. Invoke the command below to specify RPMsg sample program to be loaded:

root@smarc-rzg3s:~# echo <device> rpmsg linux-rtos example.elf >
/sys/class/remoteproc/remoteprocX/firmware

(Note 1) (Note 2)

3. Kick CM33 by invoking the command below:

root@smarc-rzg3s:~# echo start > /sys/class/remoteproc/remoteprocX/state

If CM33 starts to work successfully, the following message should be shown:

root@smarc-rzg3s:~# echo start > /sys/class/remoteproc/remoteprocO/state

[ 152.569813] remoteproc remoteprocO: powering up cm33

[ 152.647167] remoteproc remoteprocO: Booting fw image rzg3s_cm33 rpmsg linux-rtos example.elf,
size 1068216

[ 152.657050] remoteproc remoteproc(O: unsupported resource 4

[ 152.669150] remoteprocO#vdevObuffer: assigned reserved memory node vdevObuffer@0x43200000
[ 152.682507] remoteprocO#vdevObuffer: registered virtiol (type 7)

[ 152.692313] remoteproc remoteproc(O: remote processor cm33 is now up

Note: 1. <device> should be either rzg3s_cm33 or rzg3s_cm33-fpu.
2. remoteprocX can be either remoteproc0 or remoteproc1. When you would like to kick CM33,
remoteprocO should be specified. Also, remoteproc1 should be specified for kicking CM33_FPU.

4.3.4 CM33 Sample Program Invocation with BL2 of Trusted Firmware-A

On RZ/G3S SMARC EVK, you can invoke RPMsg sample program from BL2 of Trusted Firmware-A by the
procedure stated below. Be sure to configure CA55 as boot CPU when enabling this feature.

1. If you build RZ MPU VLP v4.0.1, please uncomment the following line in meta-rz-multi-os/meta-rzg/meta-
rzg3s/meta-rzg3s-vip4/conf/layer.conf

#MACHINE FEATURES:append = " RZG3S CM33 REMOTEPROC"
MACHINE FEATURES:append = " RZG3S CM33 FIRMWARE LOAD"
#MACHINE FEATURES:append = " RZG3S_CM33 COLDBOOT"
#MACHINE FEATURES:append = " RZG3S AWO SUPPORT"

If you build RZ/G VLP v3.0.7, please uncomment the following line in meta-rz-multi-os/meta-rzg/meta-
rzg3s/meta-rzg3s-vip3/conf/layer.conf

#MACHINE_FEATURES_append = " RZG3S_CM33_REMOTEPROC"
MACHINE FEATURES append = " RZG3S_CM33 FIRMWARE LOAD"
#MACHINE_FEATURES_append = " RZG3S_CM33_COLDBOOT"
#MACHINE FEATURES append = " RZG3S_AWO SUPPORT"
R01QS0085EJ0400 Rev.4.00 Page 16 of 24

Mar.31.26 RENESAS



RZ/G3S

Quick Start Guide for RZ Multi-OS Package

Rebuild Trusted Firmware-A.

3. Re-program the resultant BL2 and FIP binary files using FlashWriter.

below:

e For Boot Mode 1

Program rzg3s_cm33_rpmsg_<com_type>_example.srec using FlashWriter with the parameter stated

Partition Area

Start Address in sector Program Start Address

1

1000 80200000

e For Boot Mode 2

Address to load to RAM

Address to save to ROM

80200000

200000

4.4 CA55 Sample Program Invocation
On RZ/G3S SMARC EVK, you need to follow the procedure shown below to invoke CA55 sample program

running on Linux.

1. Boot up Linux by executing the following command on u-boot:

run bootcmd

2. Login as root.

smarc-<device> login: root

3. Run CA55 sample program by executing the following command on Linux.

root@smarc-<device>:~# rpmsg sample client

4. Then, you can see the following message on the console of Linux side.

kA Ak kA kA hhhkrh kA hhkhrhhkrhhkhkrkhkkhkrhkkhkhkhkhkhkhk*x*

* rpmsg communication sample program *
Rk R b b b b b b b b b b b b b b b b b b b b b b b b db b i b d b b b 2 b b b b b g

1. communicate between CM33 cores
2. communicate between CM33 and CAS55

e. exit

please input
>

5. Input the number which performs the communication you would like to try on the console. Please note
that 1 is allowable ONLY when remoteproc support is enabled. Also, you must NOT invoke the CM33
program in advance. Meanwhile, in case of selecting 1, you need to invoke the CM33 program in

advance.

R01QS0085EJ0400 Rev.4.00
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6. In case of typing 1, the communication between CM33 cores should be established and the
communication log is repeatedly displayed via the Pmod USBUART. Also, when 2 is typed, you can see
the following message on Linux console:

[XXX]

metal:
metal:

[XXX]

metal:

[XXX]
[XXX]

metal:

[XXX]
[XXX]

metal:

[XXX]
[XXX]

metal:

[XXX]
[XXX]

metal:

[ XXX]
[XXX]

metal:

proc_id:0 rsc_id:0 mbx id:0

info: metal uio dev open: No IRQ for device 10400000
info: metal uio dev open: No IRQ for device 11010000
Successfully probed IPI device

info: metal uio dev open: No IRQ for device 42f£f00000

Successfully open uio device: 42f00000.rsctbl.
Successfully added memory device 42f00000.rsctbl.
info: metal uio dev open: No IRQ for device 43000000
Successfully open uio device: 43000000.vring-ctlO.
Successfully added memory device 43000000.vring-ctlO.
info: metal uio dev open: No IRQ for device 43200000
Successfully open uio device: 43200000.vring-shmO.
Successfully added memory device 43200000.vring-shmO.
info: metal uio dev open: No IRQ for device 43100000
Successfully open uio device: 43100000.vring-ctll.
Successfully added memory device 43100000.vring-ctll.
info: metal uio dev open: No IRQ for device 43500000
Successfully open uio device: 43500000.vring-shml.
Successfully added memory device 43500000.vring-shml.
info: metal uio dev open: No IRQ for device 42£f01000
Successfully open uio device: 42f01000.mhu-shm.
Successfully added memory device 42f01000.mhu-shm.
Initialize remoteproc successfully.
proc _id:1 rsc id:1 mbx id:0
Initialize remoteproc successfully.
proc_id:0 rsc id:0 mbx id:1
Initialize remoteproc successfully.
proc_id:1 rsc id:1 mbx id:1
Initialize remoteproc successfully.

KAAKAAKAAA KA XK A XA A XK A XA AR A A XA AR A AR A AR A A XK kK

* rpmsg communication sample program *
KAk A KA A AR A A KNI A AR A AR A A AR A AR A A AR A A A A A A Ak kK

1. communicate with CM33 chO

2. communicate with CM33 chl

3. communicate with CM33 FPU ch0

4. communicate with CM33 FPU chl

5. communicate with CM33 ch0 and CM33 FPU chl
e. exit

please input

>

.mbox-uio.

.cpg-uio.

.rsctbl.

.vring-ctl0.

.vring-shmO.

.vring-ctll.

.vring-shml.

.mhu-shm.

7. Input the number which performs the communication between CM33 and CA55 you would like to try on
the console.

RO1QS0085EJ0400 Rev.4.00
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4.5 Overview of Sample Program’s behavior

This section describes the overview of sample program’s behavior.

1. When the CA55 sample program is successfully executed, the communication channel among CA55 and
CM33 is established.

2. The CA55 sample program starts to send the message to CM33 with incrementing the message size from

the minimum value 17 to the maximum value 488. During the communication, the message as shown
below is displayed on your console:

[xxx] Sending payload number 148 of size 165
3. When CM33 sample program receives the message sent from CAS55, the echo reply is sent back to CA55

sample program.
4. When CAD5S5 receives the echo reply, the message below should be displayed on your console:

[xxx] received payload number 148 of size 165

5. After the 488-byte sized payload is sent from CA55 to CM33, CM33 sends back the echo reply, the
message indicating the termination of the communication channel is sent from CA55 to CM33. Then, the
CA55 sample program outputs the following log messages to your console:

¢ Termination message on CA55

Ahkkhk Ak kA hhkkhkdrhkhk Ak hkrhkhkhAhkkhkhkrkhkhkrhkhkhkhk*x*

Test Results: Error count = 0
ER A i b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b b

Quitting application .. Echo test end
Stopping application...

¢ Termination message on CM33

De-initializating remoteproc

Then, CM33 side re-waits for the establishment of connection channel. You can see the following log on
the console a short time later:

creating remoteproc virtio
initializing rpmsg vdev
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5. CMa33 cold boot support
This chapter describes how CA55 and CM33 related stuff should be deployed for CM33 cold boot.
Using RZ MPU VLP v4.0.1

5.1 RZ/G VLP Setup

This section described how to integrate AWO related stuff to RZ MPU VLP v4.0.1.

1. Follow the procedure from the beginning of 2.2 Building Images to (3) Add layers of SMARC EVK of
RZ/G3S Linux Start-up Guide.

2. Download Multi-OS Feature Package (r01an8260ej0400-rz-multi-os-pkg.zip) to your working directory
and run the commands stated below:

$ cd ~/rzg vlp <pkg ver>
$ unzip <Multi-OS download dir>/r01an8260ej0400-rz-multi-os-pkg.zip

$ tar zxvf r01an8260ej0400-rz-multi-os-pkg/meta-rz-features multi-os v4.0.0.tar.gz

3. If you build RZ MPU VLP v4.0.1, please uncomment the following line to use cm33 coldboot support:

#MACHINE_FEATURES:append = " RZG3S_CM33_REMOTEPROC"
#MACHINE_FEATURES:append = " RZG3S_CM33 FIRMWARE LOAD"
MACHINE FEATURES:append = " RZG3S_CM33 COLDBOOT"
#MACHINE_FEATURES:append = " RZG3S_AWO_SUPPORT"

If you build RZ/G VLP v3.0.7, please uncomment the following line to use cm33 coldboot support:

#MACHINE FEATURES append = " RZG3S CM33 REMOTEPROC"
#MACHINE FEATURES append = " RZG3S_CM33 FIRMWARE LOAD"
MACHINE FEATURES append = " RZG3S CM33 COLDBOOT"
#MACHINE FEATURES append = " RZG3S AWO SUPPORT"

4. Continue to set up VLP by following (4) - (5) of 2.2 Building images in SMARC EVK of RZ/G3S Linux
Start-up Guide.

5.2 Deployment of CA55 Build Artifacts to SMARC EVK

If CM33 is configured as Boot CPU, you need to follow the procedure stated below for deploying bootloader
files, Linux kernel image, device tree and rooffs:

1. Follow 3. Preparing the SD Card, 4.1 Preparation of Hardware and Software, 4.2 Startup Procedure
and 4.3 Download Flash Writer to RAM of SMARC EVK of RZ/G3S Linux Start-up Guide to Invoke
Flash Writer.

(Optional for Flash Writer settings)
2. Change the transfer rate of Flash Writer from the default one (115200bps) to the high speed one
(921600bps) as shown below:

> sup
Scif speed UP
Please change to 921.6Kbps baud rate setting of the terminal.
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3. Program bl2_no_bp_spi-smarc-rzg3s.srec with Flash Writer as shown below:

===== Qspil writing of RZ/G3 Board Command =============
Load Program to Spiflash

Writes to any of SPI address.

Program size & Qspi Save Address

===== Please Input Program Top Address ============
Please Input : H'aleOO

===== Please Input Qspi Save Address ===

Please Input : H'200000

Please send ! ('.' & CR stop load)

Send bl2_no_bp_spi-smarc-rzg3s.srec via terminal software (e.g., TeraTerm) after the message
Please send ! ('." & CR stop load) is output on your console as shown above.

When bl2_no_bp_spi-smarc-rzg3s.srec is programmed successfully, the following message is shown
on your console:

Erase SPI Flash memory...

Erase Completed

Write to SPI Flash memory.

======= Qspil Save Information ============== ===
SpiFlashMemory Stat Address : H'00200000
SpiFlashMemory End Address : H'0021EB58

SPI Data Clear (H'FF) Check : H'00000000-0000FFFF,Clear OK?(y/n)

Finally, type y to continue
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4. Program fip-smarc-rzg3s.srec with Flash Writer as shown below:

For RZ MPU VLP v4.0.1:

Qspi writing of RZ/G3 Board Command

Load Program to Spiflash
Writes to any of SPI address.

Program size
Please
Please Input
Please
Please Input
Please send

& Qspi Save Address
Input Program Top Address
H'O
Input Qspi Save Address
H'260000
' ("." & CR stop load)

For RZ/G VLP v3.0.7:

Qspi writing of RZ/G3 Board Command

Load Program to Spiflash
Writes to any of SPI address.

Program size
Please
Please Input
Please
Please Input

& Qspi Save Address

Input Program Top Address
H'O

Input QOspi Save Address
H'264000

Please send ! ('.' & CR stop load)

Send fip-smarc-rzg3s.srec via terminal software (e.g., TeraTerm) after the message Please send ! (".' &
CR stop load) is output on your console as shown above.

When fip-smarc-rzg3s.srec is programmed successfully, the following message is shown on your
console:

Erase SPI Flash memory...
Erase Completed

Write to SPI Flash memory.
Qspi Save Information
SpiFlashMemory Stat Address
SpiFlashMemory End Address

H'00264000
H'00342B6E

SPI Data Clear (H'FF) Check H'00000000-0000FFFF,Clear OK?(y/n)

Finally, type y to continue.

5.3 Setup and deployment of CM33 related stuff

Refer to 4.2 CM33 Sample Program Setup and follow the procedure including the item "(Optional for
CM33 cold boot support)".

Note: Do not follow the procedure "(Optional for remoteproc support)" at this time.
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6. Reference Documents

¢ RO01AN5924 RZ/G2L RZ/G2LC RZ/G2UL RZ/G3S RZ/G3E Getting Started with Flexible Software Package
¢ RO01UH1076 RZ/G3S SMARC Module Board User’'s Manual: Hardware
¢ RO01UH1077 RZ SMARC Series Carrier Board Il User's Manual: Hardware
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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